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Looking into the future has fascinated mankind for ages. With the advent of computers we do 
not even need a crystal ball anymore to foresee how our country will look like in say 30 years 
time. Regular desk top PC’s now have enough computing power to help simulate future land 
use. All that is needed is a set of spatial data, modelling software and some thoughts on which 
spatial developments you expect are going to happen in the coming decades. The latter is of 
course the tricky part. By looking at current developments we may distil trends that are likely 
to continue for the coming 5 years, but looking much further is risky at best. Many 
uncertainties prevail: Will population growth come to halt? Will economic development be 
slow? Will society prefer ecological sustainability or economic prosperity? What will be the 
role of the government in steering socio-economic developments?  
 
A much favoured approach to deal with the uncertainties 
relating to future spatial developments is the use of scenarios. 
By describing several opposing views on the future we can 
simulate a broad range of spatial developments, thus offering a 
full overview on possible land-use alterations. Each individual 
outlook on the future will not necessarily contain the most 
likely prospects, but as a whole the simulations provide the 
bandwidth of possible land-use changes. The individual 
scenarios should in fact not strive to be as probable as possible, 
but should stir the imagination and broaden the view on the 
future. Important elements are: plausible unexpectedness and 
informational vividness (Xiang and Clarke, 2003).  
 
In this assignment you will be asked to simulate future land use in the Netherlands with an 
actual land-use model according to a specific scenario of socio-economic developments. First 
we will introduce the Land Use Scanner model that you are going to use. After this 
introduction you will explore the model in a hand-on exercise. When you are familiar with the 
model’s main functions you will start the actual assignment.  
 

 

Simulating the future 
has only recently 
become part of science. 
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Introducing the Land Use Scanner 

In this assignment we will use the Land Use Scanner, an integrated land-use model that has 
been used for various policy related research projects. Early applications include, amongst 
others, the simulation of future land use following different scenarios (e.g. Borsboom-van 
Beurden et al., 2007) and the evaluation of alternatives for a new national airport (Scholten et 
al., 1999). The model has been used in many outlooks on the future relating to a range of 
planning themes, such as: water management (Dekkers and Koomen, 2007; De Moel et al., 
2011); climate change (Koomen et al., 2008); the prospects of agricultural land use in the 
Netherlands (Koomen et al., 2005); and the development and evaluation of regional spatial 
strategies (Koomen et al., 2011). Apart from these Dutch applications, the model has also 
been applied in several European countries (Hoymann, 2010; Te Linde et al., 2011; Schotten 
et al., 2001). The GeoDMS framework underlying Land Use Scanner is also used in the recent 
EU-ClueScanner model that was developed for the European Commission and that now 
covers the 27 member states of the European Union at a 100meter resolution (Lavalle et al., 
2011) A full account of the original model is provided by Hilferink and Rietveld (1999), 
whereas recent applications are documented in a book by Koomen and Borsboom-van 
Beurden (2011). For an extensive overview of all publications which are related to Land Use 
Scanner, the reader is referred to www.lumos.info and www.feweb.vu.nl/gis. 
 
The Land Use Scanner is a GIS-based model that simulates future land use. Unlike many 
other land-use models its objective is not to forecast the dimension of land-use change but 
rather to integrate and allocate future land-use claims from different sector-specific models. 
The model offers an integrated view on all types of land use. It deals with urban, natural and 
agricultural functions, normally distinguishing 9 different land-use categories. The model is 
grid-based and uses 351,000 cells of 500 by 500 meter to cover the Netherlands. The full 
version of the model covers the country at a 100 by 100 meter resolution (8,775,000 cells), 
but that version cannot be freely distributed due to data restrictions. 
 

 
Current dominant land use per cell, clearly showing the raster structure. 
 
In the provided model version each cell describes the relative proportion of all land-use types 
present at a location. So a cell can contain more than one type of land use, presenting a highly 
disaggregated description of the whole country. The following image serves as an example: 
 
   Residential 11 ha Other  3 ha 
   Industrial 0 ha Infrastructure 1 ha 
   Recreation 2 ha Water  3 ha 
   Agriculture 5 ha Exterior 0 ha 
   Nature-forest 0 ha Total = 25 ha 
A cell of 25 hectares can contain many types of land use. 
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To provide a simple, single visualisation of this disaggregated description of land use maps of 
predominant land use are created. Keep in mind, however, that this representation may be a 
bit misleading. In the example-cell introduced above, residential land use is dominant with 
only 11 ha (less then half) of the total surface area of the cell (25 ha).  
 
The model simulates future land use, based on the following main components:  

1. the present situation; 
2. estimates of future land use demand per sector per region and/or for the whole of the 

Netherlands (land-use claims); and 
3. suitability for a certain land use per grid cell.  

The following sections describe each of these elements. 
 
Present situation 
In the Land Use Scanner the present situation is described by:  
- current (i.e. 2000) land use; 
- policy maps showing operative (government) policies based on restrictions (yes or no);  
- thematic maps showing location characteristics of the grid cells in terms, for example, 

attractivity of the urban environment, physical characteristics (e.g. landscape quality or 
altitude), accessibility or safety issues; 

- distance decay maps that describe the presence of specific land-use types and a policy 
map within different distance ranges (1, 5 and 50 km). 

 
Regional demand 
Sector-specific models of specialized institutes, such as housing and employment models, 
provide the regional projections of land-use change that are used as input for the Land Use 
Scanner model. These are called regional claims sets in the model. 
 
Local suitability 
Suitability is a crucial component in the allocation of future land use. This suitability of a 
location (grid cell) can be interpreted as the net benefits that a land-use function derives from 
that specific location and are expressed in Euros per square meter. A high suitability for a 
certain land-use type leads to a high probability that this land-use type gets allocated. The 
value of a grid cell in a suitability map can also be negative indicating that the cell is highly 
unsuitable for a certain land use. For every location the suitability or attractiveness for the 
different land-use types is described, based on a number of site specific characteristics. The 
factors influencing this suitability are divided in three groups:  

1. present land use; 
2. policy maps; and  
3. thematic maps.  

The importance of each contributing factor is dependent on the scenario and weighted in a 
script, as will be explained in the exercise.  
 
Allocation of future land use 
The demand for land is matched with the supply of suitable land, resulting in a simulated 
future land use for each grid cell. This process is called allocation. The Land Use Scanner is 
able to use two different descriptions of land use per cell in the allocation process:  

1. a continuous description using heterogeneous cells to indicate the amount of land for 
each land-use type present at a specific location (as was explained on the preceding 
page).  

2. a discrete description using homogenous to indicate the single dominant land use at a 
particular location.  

Each description of land use has its own allocation procedure. The continuous allocation uses 
a logit function to calculate the most probable land use at that location, whereas the discrete 
allocation uses a spatial optimisation procedure that is solved though a form of linear 
programming. Appendix 1 briefly explains these different allocation procedures. 
 
This assignment uses the continuous allocation procedure, but the discrete allocation 
procedure is also included in the provided model version to provide the opportunity to 
compare the different approaches. The outcomes of the continuous model version can be 
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interpreted as the expected proportions of land to be used for the various types of land use. 
The predominant land-use maps depicting these results are similar to the outcomes of the 
discrete allocation process.  
 
The spatial developments of a number of specific land-use types (Water, Infrastructure, Other 
land use and Exterior) are not simulated through the allocation module, because they are 
either absent or having a very confined, local appearance. These normally only constitute of 
planned additions to the infrastructure network, that are directly (exogenously) inserted in the 
simulation outcomes.  
 
The functioning of the model is summarised below. 
 

Local 
suitability

Regional 
demand

Allocation module

Future land use

Current land use Thematic maps

map 1

map 2

map n

Policy maps

map 1

map 2

map n

&&

Exogenous 
developments
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B2

 
Basic layout Land Use Scanner model. 
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Exercise – Getting to know the Land Use Scanner  

To familiarize yourself with the Land Use Scanner model we ask you to go through this 
simple exercise. Read the exercise carefully!  
 
Each time an Action of your part is required during this exercise, the symbol         will be 
printed in the left margin of the page. After having completed all steps you should be able to 
use all basic functions of the model. 
 
Getting started 
Start the Land Use Scanner model. 
 
The model should now display the blank starting page entitled: Land Use Scanner - 
demo.dms. Beneath this title-bar you find:  

 the menu bar with several pull down menus,  
 a currently empty dark-grey tool-bar that can contain window-specific tools,  
 on the left hand side a TreeView that allows you to navigate through the spatial data 

collection 
 on the right hand side a currently empty light-grey data view area (for displaying 

tables and maps) 
 at the bottom a status bar that can present hints and status information 

We will concentrate on the TreeView, since that provides the easiest access to the model. 
 
Viewing spatial data 
The Land Use Scanner contains a number of spatial data sets. These can be viewed by 
browsing through the TreeView. 

1. Start by clicking on the + in front of the container (directory) called “Present” and 
again on the + in front of the subsequent “landuse” and “ggModel_2000” containers. 
This container includes 9 data-layers that describe the land use in the year 2000. The 
small globes [ ] indicate that a map of the data-layers can now be drawn in the data-
view area. 

2. View several land-use maps by trying out all three possible ways to draw a map view:  
 by double-clicking on any of the data layer names. This option allows multiple 

data layers to be drawn in the same map view window.  
 by activating (clicking on) the data layer and then simultaneously pressing the 

Ctrl-M key combination. This option will open a new map view window for 
every data layer.  

 by giving a right mouse-click on the data layer and selecting the Map View > 
Default option from the appearing menu. This option will open a new map view 
window for every data layer. 

Note that a legend appears on the right hand side that indicates that the units are 
hectares (Ha) and that values range from 0 to 25, the latter obviously being the 
maximum value for the 500x500-meter grid cells. A last column in this legend 
contains the count for each class. 
Right mouse-click on the legend area. This allows you to select the statistics function 
(one of the menu options of the pop-up menu). This option provides some basic 
statistics on the selected dataset, e.g. minimum and maximum value per gridcell and 
the total area (sum) covered by this land-use function.  
The edit palette pop-up menu option allows you to change the classification and 
colour, but we will not spend time on that (all information about these options can be 
found in the user guide, also available on www.objectvision.nl).  

3. The tool-bar now contains several standard GIS-functions like: 
 zoom in, zoom out,         pan, get info, 
 
       set to full extent, copy visible area to clipboard, toggle scalebar. 

 
Explore these functions to familiarize yourself with their possibilities. See for a 
description of all tools the user guide.  
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4. The individual land-use maps do not offer a coherent view on land use in the country 
so we will try out a different way of looking at these data layers.  
Close all opened map views (menu option Window > Close All) and then open the 
Predominant (per cell land use predominance) container and the 
Predominant_in_9_classess_2000 data layer.  
You should now have a view similar to the figure below. This map shows for every 
grid-cell the land-use function that covers the most hectares. It clearly indicates the 
most notable features of the country: a network of big cities in the west of the 
country, a number of large nature areas along the coast and in the middle of the 
country, and lots (two thirds of the land surface!) of agricultural land in between. 
Note that with 9 land-use classes the predominant land use may only cover 3 of the 
total of 25 hectares of the gridcell when all land-use function have a more or less 
similar share. 
 

 
Dominant land use in the Netherlands for the year 2000. 

 
5. The Land Use Scanner also contains a collection of spatial data sets that are relevant 

for the simulation of future land use. These sets are considered when suitability is 
defined.  
Take 10 minutes to browse through the containers containing policy maps and 
thematic maps. You will find policy maps related to e.g.: existing spatial plans for 
urban extensions, nature policy, water management, planned infrastructure. The 
thematic data are mainly related to the locational preferences of the various land-use 
functions and indicate among others: urban and rural attractivity, accessibility, noise 
disturbance and landscape characteristics. A description of all available data layers is 
provided in appendix 3. 

 
Defining suitability 
Future scenarios are implemented in the Land Use Scanner through sets of maps that reflect 
suitability and exogenous developments and a table with land-use claims. In the assignment 
that follows this exercise these scenarios will be introduced. Now will first explore the model, 
starting with the way suitability is included in the model.  

1. Start by opening the A1_Best scenario in the Scenarios > Spatial container. Now 
open the Residential land-use suitability map and write down the minimum and 
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maximum value in the statistics. Zoom in at city level and save a bitmap of that 
particular situation. 

2. Inspect the definition of the suitability map that you opened by right-clicking on the 
appropriate data layer and selecting the edit config source option. You may also hit 
the Crtl+E keys after selecting the data layer. This will open a text editor at the line of 
the script that defines the data layer you just opened. Note that this option will only 
work when you properly refer to the text editor of your choice. This reference is made 
in the General settings tab in the Options menu available from the pull down menu 
option Tools: 
 

 
 
By default, the Crimson Editor (downloadable from: www.crimsoneditor.com) is 
configured in the geo-DMS. The appropriate line number and file name are provided 
to the editor by means of the parameters ( /L:%L “%F”). Make sure that the correct 
pathname is used to refer to the location where the editor is installed.  

3. All suitability maps of a scenario are defined in a single compact text file that holds 
the scenario-name. The file looks like this:   
 

 
Part of the A1.dms suitability script 

 
It contains a header and a series of text lines relating to the actual suitability of the 
various land-use functions. See for example the suitability script of the residential 
land-use function in the figure above.  
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A function’s suitability is distinguished in values related to: 
1) current land use; 
2) policy maps;  
3) thematic maps; and 
4) distance decay maps.  
These four segments are separately indicated under each land-use function. 
 
Note that most available spatial datasets are included in the script, but apart from the 
one that relates to current land use all values (the encircled numbers) are set to zero. 
This means that the suitability of a land-use function is currently only related to 
present land use. This is a good start because we normally want to preserve land-use 
functions on their current location. Remember that we will simulate the total of 
current land use and additional claims on a blank map. To include the preferred 
locations for the future development of specific land-use functions we will however 
need to add values to the relevant datasets. Doing this in a structured way that is 
coherent with the storyline of the scenario is the objective of the upcoming 
assignment. For now we will only practice adjusting the script. 
 
Please only adjust the values in the encircled area, so do not for example change the 
km or Percent values at the end of the lines. You may however also change the signs 
of the values in front of the lines, indicating whether a map increases (“ + value …”) 
or decreases (“ - value …”) the suitability of a land-use function. 
 
As a guideline, you can use the following values for indicating the importance of the 
various datasets/policies/maps: 
Importance Value 
Not important 0.0 
Somewhat important 1.0 
Important 3.0 
Very important 5.0 

 
Of course, you are free to choose values outside these guidelines. For example, if you 
really want to stress the importance, you could set the value to 15.0 and see what the 
effect is on your simulation result. Note, however, that the maximum total suitability 
value for each land-use type should stay below a certain threshold (around 80) to 
prevent computational errors during simulation. 
 
Scroll down to the part of the A1.dms script that relates to the function Residential 
land use, which is indicated by a green heading with the word residential in capitals. 
Change the values for residential spatial plans and AttractivitySurroundings 
(indicating the attractivity of the surrounding landscape) from 0 to 5. Make sure you 
save the changes you made. 
Reopen the Land Use Scanner by hitting the ALT and R keys simultaneously or by 
going to the File dropdown menu, choose open configuration file, and select the 
demo.dms file. DO NOT SAVE THE CHANGES MADE TO THE CURRENT 
DEMO.DMS FILE!  
Note Reopening the Land Use Scanner allows the model to take your update in the 
scenario-script into account. You can now redraw the changed suitability map for 
residential land use in the A1 scenario. This map should include the plans for 
residential extensions and an indication for attractive landscapes.  
Compare the current minimum and maximum values with the original ones that you 
wrote down in step 1. Have the values changed as you expected them to? Also check 
whether the pattern reflects that of the underlying data-layers by adding these to the 
map view and compare it with the saved bitmap. 

 
Other scenario components 
Apart from suitability, scenarios are defined through their exogenous land-use developments 
and land-use claims. 
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1. The container Scenarios > ExogenousLanduse > A1 contains the expected exogenous 
developments. It contains the expected future land use for the functions that are not 
simulated by the allocation module. Most of these functions are not expected to 
change at all; the boundaries with the bordering countries are fixed and we aim to 
keep the water level constant. The future situation of these functions will thus be 
equal to the current situation. Only some planned additions to the rail network are 
included in the infrastructure layer. For sake of simplicity these are kept the same for 
all scenarios. We will not pay any further attention to this issue.  

2. Each land-use function demands a certain surface area. For each scenario, the demand 
per land-use type may vary. For example, in a scenario with higher population 
growth, it is presumable that more space will be needed for residential areas, thus the 
land-use claim (in hectares) for residential will be higher. The container Scenarios > 
RegionalClaimSets > A1 contains the land-use claims for each land-use type. These 
claims are included per region.  
For instance, doubleclick on the map Residential_claims. A table will be displayed in 
the DataView listing the land-use claims for 40 regions. Also, in the TreeView you 
can see that a map of the residential claims can also be drawn. Close (exit) the table in 
DataView and then doubleclick on the A1-mapitem in the TreeView to draw the map 
of the claims in the DataView. 
Note that it is not necessary for all land-use claims to add up exactly to the amount of 
land available (the current land use), i.e. there can be over-demand or over-supply of 
land. 

 
Simulating future land use 

1. In the TreeView, click on Simulations > A1_Best. Within this container you will find 
a results container. Within this container open the sub-container labelled continuous. 
When you open this container. you will see two subcontainers: LandUse and 
evaluation. The container LandUse contains result maps of all nine land-use types for 
2030 (subdivided in two subcontainers: Endogenous and Exogenous land use) and a 
map with the predominant land use per cell only (Predominant_in_9_classes). You 
can, for example, compare the maps of predominant land use in 2030 with the map of 
predominant land use in 2000. 

2. The container evaluation contains a set of evaluation measures, which are described 
below: 
 Two table-containers, CurrentLanduse and AllocatedLanduse.  

Double-click on the container label AllocatedLanduse and a table listing allocated 
land use in hectares will be drawn in the DataView.  
Copy-Paste the contents of this table to Excel by clicking on the Copy-Paste icon 
now visible in the Toolbar       and then selecting Edit > Paste (or CTRL+V) in 
Excel. Using both current and allocated land use, you can numerically see the 
differences between the endogenous land use in 2000 and in 2030 and calculate 
percentages et cetera. 

 The container DifferenceMaps_ggEndogenous contains five difference maps of 
the endogenous land-use types. The maps indicate the difference between land 
use of a certain type in 2030 and 2000. The difference is scaled from –25 to + 25 
hectares per cell. 

 The container Urbanisation contains several evaluation measures that were 
developed specifically for analysing the effects of urbanisation (see Ritsema van 
Eck and Koomen, 2008, for more details). The indicators describe:  
- urbanisation sec, by creating maps of current and allocated built-up areas and 

calculating a difference map; 
- urban pressure on nature and landscape, distinguishing pressure on net 

Ecological Main Structure (netEHS), BirdHabitatareas and pressure on areas 
of high quality landscapes;  

- urban area size, capturing the size of individual urban areas 
(BuiltupAreaSizePerCel) in both the current and allocated situation, and an 
additional statistic for each situation describing the average size of the urban 
areas. 
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3. Familiarise yourself with these evaluation measures by opening several maps, see if 
you understand the interpretations of the maps you open. 
As soon as you draw the map of predominant land use in 2030 or use one of the 
evaluation measures, the model will run the scenario and calculate the results. This 
may take several minutes. After the results have been calculated, they are kept in 
memory and therefore opening other evaluation measures or displaying other 
allocated land use will go fast. 

 
Closing a session 
In the menu-bar, click on File > Exit and choose No in the appearing question box:  
DO NOT SAVE THE CHANGES MADE TO THE CURRENT DEMO.DMS FILE! 
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Assignments – Modelling the future of the Netherlands 

Now you are familiar with the model it is time to bring this new-found knowledge into 
practice. You are provided with a fully functional copy of the Land Use Scanner that already 
contains a basic reference to four socio-economic scenarios. Scenario-specific land-use claims 
have been added to the model and all available spatial datasets are included in the suitability 
maps. No weights have been added to these maps however. The land-use claims and 
suitability maps are combined in the allocation module and results are available from the 
Simulations container. 
 

 
 
Assignment 1 Simulate land use according to a scenario  
To generate maps related to Dutch land use in 2030 we request you to do the following: 

1) All group-members should take a look at the list with available spatial data as 
included in the table below. A more detailed description of each data layer is 
included in appendix 3.  
Indicate individually which spatial data are relevant for your specific scenario in 
general (for all land-use types) based on the scenario descriptions included in 
Appendix 2. Specify the relevance of each relevant dataset on a scale from 1 
(minor importance) to 5 (extremely important). Non-relevant datasets should 
keep the value 0. 
 

   Values in script 

Main group Theme Data layer A1 A2 B1 B2 

policy_maps Spatial_plans Residential     
  Industrial     
  Recreation     

 NatureLandscape BirdHabitat     
  Net_EHS03     

 Water Intake_reservoir     
  Disaster_retention     
  Space_for_rivers     
  Groundwater_protection     
  Groundwater_intrusion     

thematic_maps Residential UrbanAttractivity     
  AttractivitySurroundings     

 Accessibility Dist_mainports     
  Dist_NSstation2001     
  Dist_highwayExits     
  Dist_100000inh     
  Dist_100000jobs     

 Noise Perc_opp_gt_50dba     

 NatureLandscape Landscape_quality4K     
  Landscape_experience     
  Altitude     
 Safety FloodWaterDepth     
  EarthQuakes     

It is your task to simulate the future of the Netherlands according to a specific 
scenario or policy alternative. For this assignment you are asked to either: 

1. simulate land-use patterns according to one of the four scenarios by selecting 
and weighing the various components of the suitability maps in order to 
match the storylines of the scenarios; or 

2. optimise land-use patterns according to specific policy objectives by adjusting 
the suitability maps and possibly also the demand for land. 

 
The two different assignments are described below. 
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  DangerousSites     
  DangerousTransport     

DistanceDecay LandUse2000 Amount of specific land-use types in 
range of 1, 5 or 50 km 

    

 PolicyMaps Amount of BirdHabitat area within 1km     
  Amount of net_EHS03 area within 1km     

Note that the policy maps related to infrastructure development that are also present in the container 
policy_maps are used to define future changes in the exogenous infrastructure class. We will not pay 
attention to these developments in this assignment. 
 

2) Discuss the possibly conflicting views on the relevance of the spatial datasets in 
your group and decide upon a joint valuation of the components that make up 
your suitability maps.  

3) The next step is to actually adjust the suitability maps for all individual land-use 
types in your scenario. You can do this by changing the appropriate values in the 
scenario-script (e.g. A1.dms) in the text editor. As a start you can use the values 
that you agreed upon in the previous step. Note that the data-layers that are 
important for a scenario in general are not necessarily relevant for all individual 
land-use types. Some data-layers will be important for urban functions others for 
nature etcetera.  
Keep in mind that the suitability values reflect the net benefits of a certain 
location for a specific land-use type. This should provide a rationale (as well as 
limits) for your range of suitability values. Moreover, take care that for 
computational reasons there is a maximum value for the suitability of land-use 
types. Since the Land Use Scanner uses the Suitability in an exponential function, 
high values for this variable will cause a numerical overflow error and will stop 
the simulation. Therefore, try to keep the range of the suitability values of your 
land-use types between –20 and +40 Eur_m2, as the legend of the suitability maps 
also indicates.  
Finally, save the script and re-start the Land Use Scanner (re-opening the map 
window will not run the script).  

4) Take a look at the resulting suitability maps per land-use function and discuss 
whether these are coherent with your initial thoughts on the scenario. Results can 
be analysed by comparing saved bitmaps and statistics of the situation before and 
after you change the script. 

5) Simulate future land use by running the appropriate simulation (e.g. Simulations  
-> A1_Best). Check the resulting maps on consistency with the storylines of 
scenario, e.g. by making maps that depict dominant land use and the changes 
form the current land use. Discuss which adjustments are needed. 

6) Adjust the suitability maps and rerun the model until the results correspond with 
your views on the scenario. 

7) Summarize the results by making characteristic maps of future land use. Make 
use of the possibilities for creating evaluation maps that describe dominant land 
use, the changes as compared to the current situation and impacts on natural areas 
and landscape values. You can export result maps to, for example, ArcGIS, to 
create more elaborate impact assessments and/or more refined maps. 

8) Prepare a Powerpoint-presentation of 5-10 minutes with your group in which you 
offer your selection of relevant maps. Discuss the results in terms of: the rationale 
for the weights you applied to the suitability data layers, their coherence with 
storylines, the validity of your results, possible shortcomings in the simulation 
process, and its general usefulness for policy-purposes.  
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Assignment 2 Optimise land use according to a set of policy objectives  
The Land Use Scanner model is also able to optimise land-use patterns according to specific, 
spatially explicit policy objectives (see, for example, Koomen et al., 2011). In this assignment 
you are asked to consider one of the following three different objectives:  

a. water management (protecting the hydrological cycle, land use follows hydrological 
conditions etc.);  

b. safety and public health (limiting all kinds of risk to society); or 
c.  nature conservation (preserving biodiversity and strengthening the nature network). 

To optimise Dutch land use in 2030 according to one of these objectives you will start to 
work with the land demand following the A1 scenario. This is an arbitrary choice as the 
policy objectives are not directly related to the scenario assumptions, but selecting the A1 
scenario has the advantage that a substantial amount of land-use change occurs making it 
easier to see the impact of your choices. One could argue that optimised land-use patterns 
according to this scenario prepare policy makers for worst case conditions: you try to meet 
specific objectives under conditions of substantial urban growth. We ask you to follow the 
steps below: 

1) All group-members should take a look at the list with available spatial data as 
included in the table below. A more detailed description of each data layer is 
included in appendix 3.  
Indicate individually which spatial data are relevant for your specific policy 
objective in general (for all land-use types) based on your interpretation of this 
policy theme. Note that it may be necessary to first define for yourself what you 
consider to be important spatially explicit policy measures to improve land-use 
patterns according to these rather general themes. Specify the relevance of each 
relevant dataset on a scale from 1 (minor importance) to 5 (extremely important). 
Non-relevant datasets should keep the value 0. 
 

   Values in script 

Main group Theme Data layer Water Safety Nature 

policy_maps Spatial_plans Residential    
  Industrial    
  Recreation    

 NatureLandscape BirdHabitat    
  Net_EHS03    

 Water Intake_reservoir    
  Disaster_retention    
  Space_for_rivers    
  Groundwater_protection    
  Groundwater_intrusion    

thematic_maps Residential UrbanAttractivity    
  AttractivitySurroundings    

 Accessibility Dist_mainports    
  Dist_NSstation2001    
  Dist_highwayExits    
  Dist_100000inh    
  Dist_100000jobs    

 Noise Perc_opp_gt_50dba    

 NatureLandscape Landscape_quality4K    
  Landscape_experience    
  Altitude    

 Safety FloodWaterDepth    
  EarthQuakes    
  DangerousSites    
  DangerousTransport    
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DistanceDecay LandUse2000 Amount of specific land-use types in 
range of 1, 5 or 50 km 

   

 PolicyMaps Amount of BirdHabitat area within 1km    
  Amount of net_EHS03 area within 1km    

Note that the policy maps related to infrastructure development that are also present in the container 
policy_maps are used to define future changes in the exogenous infrastructure class. We will not pay 
attention to these developments in this assignment. 
 

2) Discuss the possibly conflicting views on the relevance of the spatial datasets in 
your group and decide upon a joint valuation of the components that make up 
your suitability maps.  

3) The next step is to actually adjust the suitability maps for all individual land-use 
types in your policy alternative. You can do this by changing the appropriate 
values in the scenario-script (in this case A1.dms) in the text editor. As a start you 
can use the values that you agreed upon in the previous step. Note that the data-
layers that are important for a policy alternative in general are not necessarily 
relevant for all individual land-use types. Some data-layers will be important for 
urban functions others for nature etcetera.  
Keep in mind that the suitability values reflect the net benefits of a certain 
location for a specific land-use type. This should provide a rationale (as well as 
limits) for your range of suitability values. Moreover, take care that for 
computational reasons there is a maximum value for the suitability of land-use 
types. Since the Land Use Scanner uses the Suitability in an exponential function, 
high values for this variable will cause a numerical overflow error and will stop 
the simulation. Therefore, try to keep the range of the suitability values of your 
land-use types between –20 and +40 Eur_m2, as the legend of the suitability maps 
also indicates.  
Finally, save the script and re-start the Land Use Scanner (re-opening the map 
window will not run the script).  

4) Take a look at the resulting suitability maps per land-use function and discuss 
whether these are coherent with your initial thoughts on the policy objective. 
Results can be analysed by comparing saved bitmaps and statistics of the 
situation before and after you change the script. 

5) Simulate future land use by running the appropriate simulation (i.e. Simulations   
-> A1_Best). Check the resulting maps on consistency with the policy objectives, 
e.g. by making maps that depict dominant land use and the changes form the 
current land use. Discuss which adjustments are needed. 

6) Adjust the suitability maps and rerun the model until the results correspond with 
your views on the policy objective. 

7) In order to meet your policy objectives you can also consider the implementation 
of policy measures that change the demand for land (e.g. limit the amount of 
urban land by prescribing higher building densities, or expand the demand for 
nature by launching a more ambitious nature development programme). Discuss 
such options in your group and decide upon a justifiable change in demand. You 
can implement the changed demand in the Microsoft access database in 
LUS_DEMO\data\Scenarios\RegionalClaimSets\RB_claims.mdb. Access may 
frighten you a bit at first, but it works quite intuitively. The database contains a 
table for each land-use type that specifies the amount of additional land that will 
be added to current (2000) land use per region and per scenario. Some land-use 
types have only one region (Nature_Forest), while others are specified at a more 
detailed regional level (Provinces, COROP-region or LEI14 -agricultural- 
regions). You can type the changed demand directly in the database table (after 
clicking on a field) or copy pre-calculated demand figures from, for example, 
excel and paste these over the table figures. Make sure you change figures in the 
A1 columns as this is the base-scenario you use in your optimisation. 

8) Once you have changed the demand you can rerun the simulation (after re-
opening Land Use Scanner) and discuss whether the results match your 
expectations.  
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9) When you are satisfied with your results, summarize the results by making 
characteristic maps of future land use. Make use of the possibilities for creating 
evaluation maps that describe dominant land use, the changes as compared to the 
current situation and impacts on natural areas and landscape values. You can 
export result maps to, for example, ArcGIS, to create more elaborate impact 
assessments and/or more refined maps. 

10) Prepare a Powerpoint-presentation of 5-10 minutes with your group in which you 
offer your selection of relevant maps. Discuss the results in terms of: the rationale 
for the weights you applied to the suitability data layers, their coherence with the 
policy objectives, the validity of your results, possible shortcomings in the 
simulation process, and its general usefulness for policy-purposes.  
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Appendix 1 Land Use Scanner Background 

The Land Use Scanner employs two approaches to simulate the probability that a certain 
location is chosen for a specific land use. These two approaches, continuous and discrete, are 
described below in different paragraphs. An extensive discussion on both allocation 
approaches and a comparison of their performance is provided in a report by Loonen and 
Koomen (2009). 
 
A crucial variable for both approaches is the suitability scj for land use of type j in grid cell c. 
This suitability can be interpreted to represent the net benefits (benefits minus costs) of land-
use type j in cell c. The higher the benefits (suitability) for land-use type j, the higher the 
probability that the cell will be used for this type. The economic rationale that motivates this 
choice behaviour resembles the actual functioning of the land market. The model is 
furthermore constrained by two conditions: the overall demand for the land-use functions 
which is given in the initial claims and the total amount of land which is available for each 
function.  
 
Continuous allocation 
The original, continuous model employs a logit-type approach, derived from discrete choice 
theory. Nobel prize winner McFadden has made important contributions to this approach of 
modelling choices between mutually exclusive alternatives. In this theory, the probability that 
an individual selects a certain alternative is dependent on the utility of that specific 
alternative, in relation to the total utility of all alternatives. This probability is, given its 
definition, expressed as a value between 0 and 1, but it will never reach these extremes. When 
translated into land use, this approach explains the probability of a certain type of land use at 
a certain location, based on the utility of that location for that specific type of use, in relation 
to the total utility of all possible uses. The utility of a location is in our case expressed as the 
suitability for a certain use. In combination with the constraints related to demand for land 
and the amount of available land per cell the following doubly constrained logit-model can be 
formulated:  
 

 
In which: 
Mcj is the expected amount of land in cell c that will be used for land-use type j . 
aj is the demand balancing factor that ensures that the total amount of allocated land for 

land-use type j equals the sector-specific claim. 
bc is the supply balancing factor that makes sure the total amount of allocated land in 

cell c does not exceed the amount of land that is available for that particular cell. 
 is a parameter that allows for the tuning of the model. A high value for  makes the 

suitability more important in the allocation and will lead to a more mixed use land 
pattern, strongly following the suitability pattern. A low value will produce a more 
homogenous land-use pattern. 

e is the base for natural logarithms (=2.71828 ) 
scj is the suitability of cell c for land-use type j, based on its physical properties, 

operative policies and neighbourhood relations. 
 
The outcomes of the model are thus based on various external model results, a probability 
approach and many operational choices of the model user. The results should therefore not be 
interpreted as an exact prediction for a particular location but rather as a probable spatial 
pattern of land-use change. 
 
Discrete allocation 
The discrete allocation approach allocates equal units of land (cells) to those land-use types 
that have the highest suitability, taking into account the regional land-use demand. This 
discrete allocation problem is solved through a form of linear programming. The solution of 

)( cjs
cjcj ebaM

 
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which is considered optimal when the sum of all suitability values corresponding to the 
allocated land use is maximal.  
 
This allocation is subject to the following constraints: 

- the amount of land allocated to a cell cannot be negative; 
- in total only 1 hectare can be allocated to a cell;  
- the total amount of land allocated to a specific land-use type in a region should be 

between the minimum and maximum claim for that region. 
 
Mathematically, we can formulate the allocation problem as: 

 
 
 

subject to:  
0cjX  for each c and j; 

1
j

cjX  for each c; 

jr
c

cjjr HXL   for each j and r for which claims are specified; 

in which: 
Xcj  is the amount of land allocated to cell c to be used for land-use type j; 
Scj is the suitability of cell c for land-use type j; 
Ljr is the minimum claim for land-use type j in region r; and 
Hjr is the maximum claim for land-use type j in region r. 
 
The regions for which the claims are specified may partially overlap, but for each land-use 
type j, a grid cell c can only be related to one pair of minimum and maximum claims. Since 
all of these constraints relate Xcj to one minimum claim, one maximum claim (which cannot 
both be binding) and one grid cell with a capacity of 1 hectare, it follows that if all minimum 
and maximum claims are integers and feasible solutions exist, the set of optimal solutions is 
not empty and cornered by basic solutions in which each Xcj is either 0 or 1 hectare. 
 

 

 


cj

cjcjX XSmax
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Appendix 2 Description of the four scenarios 

The assignment contains four scenarios for future spatial developments. They provide a 
coherent framework for studying the distinguished developments and are ordered following 
two opposing trends: 
- global (1) vs. regional (2); and 
- market economy (A) vs. cooperation (B). 

 
The four resulting scenarios are depicted below: 
 

 
Global market combines globalisation with individualism, whereas Regional cooperation 
connects regionalism with cooperation. In the A-type scenarios, people tend to focus more on 
material values, whereas in the B-type scenarios, they focus on immaterial values. Likewise, 
in a 1-type world cultural and economic globalisation is an important trend where in a 2-type 
world the opposite is the case. Each combination of trends (i.e. scenario) has specific 
characteristics, which are summarised below.  
 
A1: The ‘Global Market’ scenario assumes a continuing globalisation and liberalisation, 
resulting in high economic growth and a fast introduction of new technologies. In this 
capitalized, market-oriented and individualistic world civilians are strongly focussed on the 
material aspects of life. The welfare state crumbles off. 
A2: In the ‘Regional Market’ scenario the traditional bands between Western Europe and the 
United States is re-enforced and a strong cultural and trade block emerges. The differences 
between the Western world and other (less wealthy) regions increase. Traditions are important 
in this world, which shows itself in a society oriented towards self-sufficiency, an industry 
aimed at ‘improving the existing’ instead of radical changes and civilians aimed at family 
values, status and comfort.  
B1: In the ‘Global Cooperation’ scenario globalisation continues, not only aimed at 
removing trade barriers but also on exchange of knowledge and technologies between 
industrialised and developing countries. There is a general concern for the division of wealth 

Global market (A1) Global cooperation (B1 )

Regional market (A2) Regional cooperation (B2)

Orientation on material values

    Orientation on immaterial values
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 Strong population growth and gradual
income convergence as side-effect of
high income growth

 Free trade
 Strong technological developments
 Limited role of the government
 Strong decrease in agricultural land use
 Consumption pattern: luxurious

 Strong population growth and gradual
income convergence as a consequence of
international policy

 Technological developments aimed at
knowledge transfer and durability

 Compact cities
 Consumption pattern: quality

 In some regions high population growth
caused by traditional values and low
incomes/unequal income division

 Protectionism; limited trade and transfer
of technological knowledge restrain
economic growth

 Consumption pattern: comfort

 Medium economic growth aimed at
regional durability, population decreases

 Technology aimed at efficiently using
regional sources, limited transfer of
technological knowledge

 Social and institutional structures are
aimed at the regional quality of life

 Consumption pattern: quality of life

 Characteristics of the four scenarios for the Netherlands 
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and raw material between people and for the management of nature and the environment. 
Solidarity shows itself in the form of a strong welfare state. 
B2: The ‘Regional cooperation’ scenario assumes an emphasis on the own identity and self-
sufficiency within a region. Global developments are not the general concern an receive less 
attention. People are less materialistic and more focussed on the quality of their living 
environment. Solidarity is important and the national government plays an important role in 
the division of wealth and the protection of collective interests. 
This appendix also contains the basic assumptions and related spatial implications for the four 
scenarios.  
 
The scenarios are included in the land-use model in two ways: 

1. they set regional or national land-use claims, by predicting a future surface area for 
every land-use type. 

2. they influence the relative importance of the factors that describe the suitability. 
 
The table below contains the expected total surface area of each land-use type for the four 
scenarios. These are included in the model-version that will be used for the assignment. The 
figures in this table are derived from different sector-specific models and are based on the 
trends and assumptions for each scenario. As can be seen from the claim table, three of the 
four scenarios have a total land-use demand that is greater than the current land use, 
indicating over-demand. We solve this problem in our model by taking additional land from 
agriculture assuming that this function will be the weakest (least spending power) in the 
competition for space.  
 
A more extensive description of the related basic assumptions and spatial implications is 
listed in the large table on the following page. 
 
Land-use type A1 (Best) A2 (West) B1 (East) B2 (Home) Current land 

use (2000) 
Residential 328536 341462 274001 282301 224793 
Industrial 127962 127962 134107 134107 104043 
Recreation 174608 182208 135116 136671 89642 
Agriculture 2077050 2211180 2131394 2201843 2354560 
Nature_Forest 530250 595250 647250 661250 485250 
Other 42078 42078 42078 42078 42078 
Infrastructure 87034 87034 87034 87034 82835 
Water 2852990 2852990 2852990 2852990 2852990 
Exterior - - - - - 
Total land-use 
claims 

6220508 6440164 6303970 6398274 6236191 

Expected land use (hectares) in 2030 following the four scenarios, compared to the current situation 
(2000), source: Nijs et al (2002). 
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 Global Market - A1 (Best) Regional Market -A2 (West) Global Cooperation - B1 (East) Regional Cooperation - B2 

(Home) 
Socio-economic conditions 

Economic growth Highest High Medium Low 
Population 20 million 18 million 19 million 15 million 
Societal focus Individual freedom Individual freedom Global cooperation Regional cooperation 
Recreation Not much spare time, emphasis on 

active leisure, accessibility and 
proximity to residential areas are 
important 

Much spare time (more than in A1 
and B1, emphasis is on rest & 
relaxation 

Valuable (more than in A1), people 
also like to go into nature areas, but 
some nature areas are restricted. 
Accessibility by road and by rail are 
important 

Valuable, people also like to go 
into nature areas 

General and sector-specific spatial policy 

Economic orientation Free market prevails, globalisation Free market prevails, protectionism Government intervenes, strong 
international institutions 

Government intervenes, strong 
local and regional institutions 

Spatial policy  Less restrictive policies  Less restrictive policies Restrictive policies for rural areas Restrictive policies for rural areas 

Agricultural policy Free world markets for agricultural 
products 

Internal EU support under conditions, 
no export subsidies 

Regulated world markets for 
agricultural products 

Internal EU support under 
conditions, no export subsidies 

Nature protection & 
development 

Only the most valuable natural areas 
are protected.  
International treaties are followed. 
Acquisition through private persons 
and organisations 

Symbolic role of the government, 
general trend: nature serves 
humanity. 
International treaties are followed. 
Nature appears where agricultural 
land disappears. Nature is pushed 
aside by urbanisation processes 

Global environmental policy, strong 
international institutions. International 
treaties are followed and acquisition 
by national government following 
Ecological main structure (EHS) 

Larger areas protected, Ecological 
main structure realised.  
International treaties are followed 
and acquisition by national 
government following Ecological 
main structure (EHS) 

Agriculture and nature 
conservation 

Strong decline of agricultural land 
use. No chances for agriculture 
combined with natural values 

Agricultural land use remains the 
same or decreases slightly.  No 
chances for agriculture combined 
with natural values 

Agricultural land use remains the 
same or decreases slightly. Room for 
agricultural nature management 

Decline of agricultural land use 
follows historic trend.  Diversified 
rural development, much room for 
agricultural nature management 

Water management Building near rivers is allowed Building near rivers is allowed 
reluctantly 

Restrictions on urbanisation in 
designated areas 

Restrictions on urbanisation in 
designated areas 

Expected spatial developments 

Urbanisation Urban sprawl in rural areas. 
Accessibility by road to and from 
urban areas is important. Attractivity 
of the environment is important for 
residences. 

Urban sprawl in rural areas. 
Accessibility by road to and from 
urban areas is very important. 
Proximity to an airport is important. 
Attractivity of the environment is not 
important 

Concentration near existing urban 
areas, no new residential areas near 
airports 

Concentration near existing urban 
areas, no new residential areas 
near airports and in low-lying rural 
areas 

Commercial functions Abundant growth, preference for 
highway locations 

High growth, strong preference for 
highway locations 

Medium growth, public transport 
accessibility promoted, also 
preference for highway locations 

Limited growth, public transport 
accessibility strongly promoted 

Basic assumptions and related spatial implications for the scenarios 
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Appendix 3 Overview of available spatial data 

Spatial data Land Use Scanner - demo  

Main group Theme Data layer Spatial data description Units 

landuse ggModel_2000 

(current land use in 
9 classes) 

Residential Residences and connected activities, including: 
- primary facilities: shops, schools 
- small offices of a.o. banks 
- public parks <  1 hectare, streets and parking lots 
- small playing fields, barnyards, gardens 

[0 to 25 Ha] 

  Industrial Commercial and industrial land use, including: 
- shopping malls, hotels and restaurants incl. parking lots 
- social-cultural facilities such as high schools, hospitals, museums, churches, 

cinemas, conference facilities 
- industrial or commercial areas, such as harbours, wholesale trade market, office 

buildings incl. parking lots, auction site, factory outlets 
- dump sites, extractive industries, distribution centres, seaports, wreck storage zone 

[0 to 25 Ha] 

  Recreation Green and stay recreation, including: 
- parks, public gardens and playing (sports) fields 
- allotment gardens 
- short and long stay facilities (bungalows etc.) 

[0 to 25 Ha] 

  Agriculture Agricultural land use, including: 
- arable land and horticulture (a.o. potatoes, beets, cereals, flower bulbs and 

greenhouses 
- grassland, (zero-)grazing livestock and orchards 

[0 to 25 Ha] 

  Nature_forest Nature and forest areas, including: 
- broad-leaved and coniferous forest 
- salt grassland, beach, dunes, heath land 
- peat, moors, swamp, bare soil 

[0 to 25 Ha] 

  Other Other land use, including: 
- half-built constructions (construction sites) 
- burial sites 

[0 to 25 Ha] 

  Infrastructure Railway, roads and airports [0 to 25 Ha] 
  Water Fresh and salt water, including: 

- water storage basins, lakes, rivers, sea 
- recreational water 
- reservoirs and water for extractive industries 

[0 to 25 Ha] 

  Exterior Land use outside the Netherlands; the exterior is not simulated in the Land Use Scanner - 

 Predominant  Predominant land use in 9 classes [0 .. 8 classes] 

Policy_maps Spatial_plans Residential Spatial development plans for new residential areas [Present: 1 or 0] 
  Industrial Spatial development plans for new commercial areas [Present: 1 or 0] 
  Recreation Spatial development plans for new recreational areas [Present: 1 or 0] 

 NatureLandscape BirdHabitat BirdHabitat - International (European) treaty protecting the natural habitat of birds and 
endangered species 

[Present: 1 or 0] 
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  Net_EHS03 Ecological Main Structure - Dutch spatial policy protecting particular nature areas, existing or 
still to be acquired 

[Present: 1 or 0] 

 Water Intake_reservoir Water intake polder - for water storage in case of prolonged local rainfall [Present: 1 or 0] 
  Disaster_retention River water retention areas - for water storage in case of anticipated river flooding [Ratio: 0 to 1] 
  Space_for_rivers Space reserved by National Government for widening of river flood plains, expressed in 

fraction of cell that falls within the contours of this spatial plan 
[Ratio: 0 to 1] 

  Groundwater_protection Ground water protections zone designated by regional authorities, expressed as fraction of 
cell that falls within this policy zone 

[Ratio: 0 to 1] 

  Groundwater_intrusion Ground water intrusion area not currently protected, expressed as fraction of cell that belongs 
to this area 

[Ratio: 0 to 1] 

 Infra schiphol5b Schiphol - the national airport Schiphol near Amsterdam with five runways [Present: 1 or 0] 
  HSL_Zuid Spatial plan for the High Speed Train track to Brussels and Paris [Present: 1 or 0] 
  HSL_Oost Spatial plan for the High Speed Train track to Germany [Present: 1 or 0] 
  Betuwelijn Spatial plan for a freight train track from Rotterdam harbour to Germany [Present: 1 or 0] 

thematic_maps residential UrbanAttractivity Attractivity measure of the urban environment, calculated using a.o. number of cultural 
facilities, number of hotel and catering outlets, number of shops etc. 

[%] 

  AttractivitySurroundings Attractivity measure of surroundings for residents [%] 

 Accessibility Dist_mainports Distance to mainports Schiphol airport and Rotterdam Harbour [km] 
  Dist_NSstation2001 Distance to nearest railway station [km] 
  Dist_highwayExits Distance to nearest highways exit [km] 

  Dist_100000inh Distance to nearest 100.000 inhabitants [km] 
  Dist_100000jobs Distance to nearest 100.000 jobs [km] 

 Noise Perc_opp_gt_50dba Area per cell [%] with a noise level of more than 50 dB(A) [%] 
 NatureLandscape Landscape_quality4K Landscape values [low, medium, high, very high] [0 .. 3 classes] 
  Landscape_experience Perceived attractivity of landscape [strongly negative, .. highly positive] [-4 .. 5 classes] 
  Altitude Altitude [m] 

 Safety FloodWaterDepth Average water depth resulting from worst possible flooding [m] 
  EarthQuakes Location prone to earth quakes with an intensity of VII on Mercalli scale [Present: 1 or 0] 

  DangerousSites Fraction of the surface area in a cell that is within a risk zone or immediate vicinity (100m) of 
a dangerous facility (e.g. chemical factory, storage facility for explosive material) 

[Ratio: 0 to 1] 

  DangerousTransport Fraction of the surface area in a cell that is in the immediate vicinity (100m) of a pipeline 
transporting dangerous goods 

[Ratio: 0 to 1] 

DistanceDecay LandUse2000 Land-use types in range 
of 1, 5 or 50 km 

Relative amounts of specific land-use types that can be found within different distance 
ranges. Calculated by applying a square root distance decay function that gives less 
weight to larger distances from the observed cell. Similar to moving window filters in GIS  

[Ratio: 0 to 1] 

 PolicyMaps BirdHabitat area within 
1km 

Relative amount of BirdHabitat area within 1 km range calculated by applying a square 
root distance decay function. 

[Ratio: 0 to 1] 

  net_EHS03 area within 
1km 

Relative amount of area classified as Ecological Main Structure within 1 km range 
calculated by applying a square root distance decay function. 

[Ratio: 0 to 1] 

Overview of available spatial data  


